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In the previous class you have learnt to format data and worksheet structure.
In this chapter you will be learning how to perform calculations in Microsoft Excel using
formulas and functions.

FORMULAE IN MS EXCEL

Formulain MS Excel Cell, Cell address, Cell Range
Excel Formulae are the expressions that are used for doing calculations on the worksheet
data. Excel formula are very much similar to mathematical formulae, but they are written a
bit differently.

1. Every Excel formulabegins with an equal to sign (=).

2. The '=' sign can be followed by a number, cell address, cell range, mathematical

operator or function and so on.

Here, is an example of an Excel formula with some of the basic elements it may contain:

= Al + Bl = 7 1. Equaltosing (=)
T 11 ) 2. Cell addresses (A1 and B1)
1213 4

3. Mathematical operators (+ and*)
()

_ﬁ’ [m 4. Number (7)

B The equal to (=) sign tells Excel that the characters that come next constitute a formula. If you do not enter the
equal (=) sign, Excel will treat your entry as text and your calculations will fail.
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TEXT FORMULA
Text formula is used to join two on more text values. To create a simple text value, enclose it in
double quotes and use the ampersand symbol (&) to link text values to one another. Follow
the steps given below:

= Enter two string type valuesin cell A1 and B1, say Science in A1 and Technology in B1.

= Enter the formula="Science" & "Technology"in cell C1 and press Enter.

= [twill display Science Technology in cell C1.

Remember

B The process of linking text value in a sequence within a formula is called Concatenation.

" If we want a space between the two words, leave a space before the closing quotation mark.
For example: "Hello "&"Friends"
Hello Friends

Numeric formula

Numeric formula use operators that are used to do some kind of calculation or comparison.
There are three types of operators to be used in formula; (i) Arithmetic (ii) Relational
(iii) Logical.

Out of these relational and logical operators are used for comparisons Arithmetic operators
are use for mathematical calculations. In this chapter we will study about only Arithmetic
operators.

CELLS, CELL ADDRESS AND CELL RANGE

A cell as you know is a rectangular area on a worksheet formed by the intersection of a row
and a column.
A cell address identifies the location of the cell in the worksheet. The address of a cell is
written using its column letter and row number. For example:

= Acellin column C and Row 3 will have the address C3.

= Acellin columnD and Row 11is addressed as D11.

= Acellin column F and Row 2is addressed as F2.
Acell addressin MS Excelis also called as the cell reference.
A cell range, as you know is a rectangular region on a worksheet consisting of two more cells.
The address of a cell range is generally given by the address of the first and the last cell in the
range separated by a colon (:). Forexample, theaddress A1: B4 refers to all the cells from A1 to B4.

Ml Activity

Tick (v') the correct answer in the box :

1. Which of theseis not a correct cell reference?

(a) Al | (b)H16 | (c)sB [ ]
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2. How will you address all cells from cell A5 to G5?

(a) A5, G6 || (b) A5:G6 | (0)G6, A5 [ ]
3. InExcel, each formula must begin with:
(a) =sign || (b) %sign || (c)<sign [ ]

4. Whichisnotanoperatorin Ms Excel?

(a)>= e ] @
‘ﬁj Remember

(
l B Each worksheet in MS Excel 2010 holds 1,048,576 rows and 16384 columns. ]

[ ]

Arithmetic Operatorsin MS EXCEL

Arithmetic operators used in the formula help us to perform calculations on worksheet data.
Some of the operators that we frequently use for writing formula are listed in the following
table along with some examples.

+(Addition) =A1+A2 Addsvaluesincells Aland A2

—(Subtraction) =A1-A2 Subtracts valuesin cells Al and A2

*(Multiplication) =B2*B3 Multiplies valuesin cells B2 and B3

/ (Division) =D1/D2 Divides D1 by D2 and returns the quotient

" (Exponent) =A1"A2 Calculates exponents when the value in Al
israised to the power A2

() (Parenthsis) =(A1+A2)*2 First adds the values of A1 and A2 and then
multiplies the sum by 2.

Apart from these, many other operators are also used in Excel formulae such as colon (:),
semicolon (;) percent (%), less than (<), greater than (>), Equal to (=), greater than or equal to
(>=) and so on. However, in this chapter we will learn only about the operators listed in the

table.
A

i[ ) | Remember

[ )
B Excel formulae can comprise only of numbers. For example the formula '=128*98' calculates the product of 128 an
98 and displays it in the cell.

ORDER OF OPERATORS

When performing calculations in a formula, Excel follows certain rules of precedence.
1. Excelfirst calculates expressions within parenthesis () in a formula.
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It then calculates exponentiation (*).

Multiplication (*) and Division (/) have the same order of precedence in Excel. When
both multiplication and division are present in formula, Excel evaluates the operators
from left toright.

Addition (+) and Subtraction () also have the same precedence order. When both are
presentin aformula, they are evaluated from left to right.

Remember

B When you are unsure of the order in which Excel calculates, use parenthesis- even if they are not necessary. The
use of parenthesis also makes the formula easier to read.

USING THE FORMULAE

We can enter a formula in a cell by either double clicking in the cell and typing the formula
directly into it or typing it in the formula bar after selecting the cell. Let us now learn to create
asimple formula in a worksheet by using the steps given below:

1.

Open the Ms Excel program and type the data in the cells from A1l to F1 as shown.
Notice that cell F2 is blank, but it should contain the sum of the marks in the cells B2, C2,
D2 and E2.
Double click in the cell F2 and type out the formula as shown (=B2+C2+D2+E2). Then
clickonthe Enterbutton.

.... Therequired sum will be displayed in the cell F2.
To apply the formula to other cells, point to the fill handle of the cell containing formula
(F2) and drag down to enclose cells upto Fé.
The formula will get copied to all the enclosed cells, and the total will appear in all the
cells (F3, F4, F5 and F6).
Save the file by clicking on the Save Button and then entering details as required in the
Save As dialog box.

Remember

m Theresult of a formula is displayed in the cell. Whey you select the cell containing the result, the formula is
displayed in the formula bar.



TYPES OF CELL REFERENCING

The cell address in the formula is known as the cell reference. Cell referencing means how a
cell address behave in the formula whenitis copied from one cell to the other.
There are three types of cell referencingin Ms Excel.

1. Relative referencing 2. Absolute referencing 3. Mixed referencing
Every cell has aname known as its address which is made up of a column part and s row part.
Forexample A1, B2 etc. where A, B, denotes the column partand 1, 2 denotes the Row Part.

It is called relative when both parts are not fixed. It is called absolute when both parts are
fixed. Itis called mixed when one of them is fixed.

1. Relative Referencing: Relative referencing is the normal way of addressing the cells
like A2, B2 C4 and so on. It allows us to change the cell addresses in formula when it is
copied to some other row or column. The cell addresses change according to the row or
column where the formulais copied.

A

Relative Referencing

Notice, the change in cell reference changing on each row due to relative reference.
For example, if the formula in D2 is = B2+C2, when the formula is copied vertically
downnotice that the cell address in the formula had automatically changed.

2. Absolute Referencing : Sometimes we may not want Excel to change the cell address
when we copy a formula to another cell. In such situations we can use the absolute
addressing method.

In absolute addressing, the address of a cell is made fixed by putting a $ sing, before
both the column letter and the row number of the address of a cell. For example, D2 is
relative address, whereas $D$2 is an absolute address.

A

Absolute referencing



In the above example, you see that, D2 has the for formula rows, there is no change in
the cell address.

3. Mixed Referencing : Mixed referencing is when one part of the call address is relative
and the other is absolute. So, either the column or the row number should have a $
along with it.

Mixed Referencing

For example, $B2 is a mixed cell reference with absolute column and relative row and

C$2 is a mixed cell reference with relative column and absolute row.
M@ ______________________________________________________________________________________________________________________ .

’?ﬁoylgp F By default, formula use relative referencing.

________________________________________________________________________________________________________________________ ‘l

FUNCTIONS IN MS EXCEL

AFunctionsin MS Excel is a predefined formula that allows us to perform a particular kind of
computations like adding and finding the sum of cell values, finding the average of cell

values and so on. Beginning

. . . . arenthesis .
Just like a formula, a function also begins with an Equal to P Endtlﬂg _
. . i arentnesis
equal to (=) sign, and has two main parts- the sian g

Function name and the arguments, that are lg > Ee
included within a parenthesis ( ). The sum Function = Sum (A2:
given alongside helps us to understand the

different parts of a function.

Function name
Arguments

Arguments are the values that are used by the function to perform manipulations and/or
calculations.

Arguments can be given to a function in the form of both values (numbers) and cell
addresses. For example, Sum(14,144,236), Sum(A1,A2,B6) and Sum(A2:E6) are all perfectly
valid arguments, for the sum function.
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SOME COMMON EXCEL FUNCTIONS

Excel supports hundreds of functions that can be classified into five main categories, namely
Mathematical functions, Statistical functions, Text functions, Date and Time Functions and
Logical functions. The following table lists some simple and commonly used Excel functions.

Function/Syntax

Sum() Finds the sum of values given to it as the argument. =Sum(5,9)
returns 14
Average() Finds the average of values given in the argument. =average(5,7,10,30)
returns 13
Min() Returns the smallest value from amongst the =min(6,10, 18)
arguments. returns 6
Max() Returns the largest values from amongst the arguments. = max(6,8,18)
returns 18
Count() Returns the number of cellsin a cell range (given as =count(A2:A9)
argument) that contain number values. may returns 8
Exp(num) It returns the natural logarithm raised to the power =exp(2)
of anumber. returns 7.389056099
Int(number) Itrounds anumber to the nearest integer. =int(19.375)
returns 19
Len(text) It counts the number of characters in the text. =len(computer)
returns 8
Mod(number, It returns the remainder when anumber is divided by MOD(27,4)
division) another number. returns 3
Power(number It returns the result raised to the power of anumber. Power(2, 3)
power) returns 8
Product(rangeor = Itmultiplies the numbersina givenrange of cells. Product(A1:A5)
numbers) may returns 120
Quotient(Number, Itreturnsthe quotient whenanumberisdivided by Quotient(68, 8)
denominator) another number. returns 7
Round(number, It rounds anumber to the specified number of digits. Round(19.3754, 2)
Num digits) returns 19.38

ENTERING FUNCTIONS IN A WORKSHEET

We can enter a function in a cell either manually or by using the Auto Sum drop down menu.

Entering a Function Manually
To type a function into a cell manually follow these steps :
1. Select the cell where you want to enter the formula.

2. Clickin the formulabar, and type the '='Sign.
3. Typethename of the function withoutleaving any spaces.
4. Enter therequired arguments (B2 : F2) within parenthesis ().
5. Click on the Enter (v') button.
_o0Ne
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Enter Button Function

Calculation for result

.... The value returned by the function will be displayed in the cell.

Using Autosum Menu to Enter Function
We can use the AutoSum function to sum up the values in a range of cells on a worksheet. Let
uslearn how.
1. Select the cell where you want to enter a formula.
2. Click on the drop down arrowhead button situated besides the AutoSum button.
... A drop down menu will appear listing the functions that are commonly used for
doing calculations in a worksheet.

3. Clicktoselectarequired function from the list.
Sum Function

Function and affected range selected

... The function will automatically appear in the selected cell.
4. Press the F2 key to make the cursor appear in
the cell if you want to change the arguments
given with the function.
5. Change the arguments as per your
requirements.
6. Pressthe Enterkey or click on the Enter button.
... The result will be displayed in the cell
containing the formula.

Calculated Result



TIP! Ifyou click on the More Functions.... option in the Auto Sum menu, it will open the Insert Function dialog box.
You can use this dialog box to insert any of the hundreds of functions available in MS Excel. The Insert Function
dialog box can also be opened by clicking at the Insert Function option in the Formulas tab.

SORTING OF DATA IN MS EXCEL

Sorting is the process of arranging data into a meaningful order so that we can analyze it
more effectively. Excel allows us to sort data in many ways. Some common ways are given
below :

1. Sorting textual datainto alphabetical order (from Ato Zor from Zto A).

2. Sortingnumeric data (from smallest tolargest or from largest to smallest).

3. Sorting data date-wise (from oldest to newest or from newest to oldest).

4. Sorting data on the basis of multiple column (or rows) through the Sort dialog box.

Sorting Datain Alphabetical Order

Arranging data in alphabetical order is the most common type
of sorting done in Ms Exce.l The steps to sort data in an
alphabetical order are as follows:

1. Selecta cell in a column you want to sort by. (You can also
select the entire column excluding the column heading,
if any)

2. Click on the Home tab. In the Editing group click on the
Sort & Filter button.

3. Fromthelist thatappears select the Sort A to Z option.

.... Therecords will get sorted in ascending order. Options to sort data alphabetically

T'P! To sort the records in descending alphabetical order (reverse order) click 'Sort Z to A’ option from the Sort &
Filter button menu.
Sorting Datain Numerical Order
We can also sort data in a worksheet on the basis of a field containing numerical data. The
data gets sorted in ascending or descending order. The steps are as follows:
1. Select a cell in a column you wan to sort by. (You can also
select the entire column excluding the column heading,
if any).
2. Click on the Home tab. In the Editing group, click on the
Sort & Filter button.
3. From the list that appears select the Sort Smallest to
Largest option.
... Therecords get sorted in ascending order.

Options to sort numerical data
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4. Click onthe Sort Largest to Smallest option.
.... The records will be sorted in descending order.

T")! When the date or time field is there in a worksheet, the records can be sorted and arranged from oldest to the
newest date and time or from the newest to the oldest date (or time) by selecting the respective options from
the Sort & Filter button menu.

Custom Sorting
We can also sort data in a worksheet in the order we want by creating Custom lists. The steps
to created a custom list and use it to sort data are as follows:

1. Select the cell range containing the data that you want to sort.

Custom Sort Option
2. Click on the Home tab. In the Editing group, click on the Sort & Filter button.

3. From the drop down menu select the Custom Sort Option.
.... The Sort dialog box will open.
4. Identify the column you want to Sort by, by
clicking the dropdown arrow in the 'Column'
tield. Here, sort by the column Class.
5. Make sure the option Values is selected in the
Sort On field.
6. Click the drop down arrow in the 'Order’
Field and Select the custom List option from Sort Dialog Box
the drop down menu.
7. In the Custom Lists dialog box that
appears, select the New List under
the Custom Lists section.
8. Enter the order in which you want to
sort the data in the List entries
section.
9. Click on the Add button. The sorting
order will appear in the Custom lists

Section.
10. Click on OK to close the Custom
Lists dialog box.

o008
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Note : Notice that your Custom Sort order appears in the Order field in Sort dialog box.
11. Click on OK to close the Sort dialog box.
.. The data will get sorted in accordance with your custom list.

_i{ Remember

B The Sort On field drop menu also gives you options to sort data based on cell color, font color or cell icon (provided
you have these features in your worksheet).

Ml Activity

State whether the following statements are 'True or 'False’ :

1. Acolumn of datain a Excel worksheet is also called a Record.

2. Sorting means arranging date in a particular order.

3. Datainadate ortime field can be sorted from the oldest to newest.
4. TheSort & Filter button is situated in the Sort group.

FILTERING DATA IN MS EXCEL

A tilter can be used to narrow down data in a worksheet to view only selective records. The
filter hides away the rest of the data from the view. For example, we can use a filter to view the
records of only those students out of a class who have scored 80% or more marks. Remember,
filters hide data only temporarily. Once a filter is removed, all the data in the worksheet
become visible again.

Applying Data Filters
Filters can be applied to a worksheet in many different ways. We can even apply multiple
tilters to filter away excess data and see only the data that concerns us at the moment.
Let usnow learn to apply filters with the help of an example. Here, we will apply a filter to see
th records of only class 7 students.

1. Create a worksheet as shown here.

2. Clickinany cell that contains data or select the entire date in the worksheet.

3. Selectthe Sort & Filter option. Click on the Filter button.

[SIES
&

®
//w
LS //
De y

'?JQA.
v D6



... Drop-down arrows will appear in the header of each column.
4. Click the drop-down arrow for the column you would like to filter. Here, we will filter
the 'Class' column to view records of class 7 only.
5. In the Filter menu that appears, uncheck the boxes given
before 'Class 5' and 'Class 6', leaving only 'Class 7' box
checked.
6. Click on the OKbutton.
... Now the worksheet will show only the data of Class 7
students. All other data is filtered away or hidden
temporarily.

Using Multiple Filters
We can apply more than one filter to a worksheet to make selective
viewing of data more refined. For example, suppose in the above
worksheet we want to display data of the students from Class 7
Section A only. For this we can add another filter to the Section Applying filter on worksheet
column to hide all the records except for Section A. The steps to do it
are as follows:
1. With the worksheet to which you applied a filter in the
previous example open, click the drop-down arrow of the
'Section’ column.
... The Filter menu will appear.
2. Uncheck all the check boxes except for the one placed before
A

3. Clickon OK.

Applying multiple filters

... Now the worksheet will show only those students who are
in Class 7 and Section A.

Removing Filters
It is easy to remove filters from a worksheet. Just follow the step
givenbelow :

1. Toremove afilter from a particular column, click on the Filter
drop down arrow and select Clear Filter from the 'Section'
option.

2. To remove all filters form a worksheet, simply click on the
Filter button.



A

i[ ) | Remember
[

¥ You can also access the Filter option from the Home tab where it is placed in the Sort & Filter button menu of the
Editing group.

?

E

1. Apply a text filter on the 'Name' Column to display the records of all those students whose names
begin with the letter 'a'.

2. Apply a Data filter on the 'Date of Birth' column to display the records of only those students who
are born on or after 15 August 2002.

CONDITIONAL FORMATTING IN MS EXCEL

Conditional Formatting allows us to highlight only those cells that contain data that meets a
given condition. For example, we can use a condition like 'If the marks obtained is greater
than 400, color the cell red' to highlight all the cells in the Marks obtained column.

Creating a Conditional Formatting Rule
The steps to create a conditional formatting rule are follows:

1. Create a worksheet as shown here and select the data that you want to highlight.
(Here, we, have selected data in the (Maths column.)

2. IntheHome tab, click the Conditional Formatting button.
...Adrop down menu listing the different rule categories will appear.

Conditional formatting applied to the data
[SIES
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3. Here we have selected Highlight Cells Rules category.
....Asub-menu will appear showing the different rules in the category.
4. Selectthe desired rule (we have selected Greater Than....).

5. In the dialog box that appears, enter a suitable value in the 'Format Cells that are
GREATERTHAN:' textbox.

6. Select a required formatting option from the formatting drop down list (Custom
Format option if checked, will give the Format Cells dialog box to let you define the
formatting for the cells on your own.)

7. Click on OK button. All the cell containing values greater 400 will get highlighted.

TIP! 1. Wecanapply morethan one conditional formatting rules to the selected data.
2. New conditional formatting rules can also be set by clicking on the New Rules option in the Conditional
Formatting menu.
Removing Conditional Formatting
Itis easy to remove conditional formatting from a
worksheet. Just follow the steps given below :

1. Select the cells with conditional formatting.

2. In the Home tab, click the Conditional
Formatting command button.

3. Inthe drop down menu that appears, select
the Clear Rules option.

4. In the Clear Rules submenu, select a
desired option to clear the rules from the
selected cells, entire sheet and so on.

...The desired conditional formatting will
be removed.

Clear Rules Submenu
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l Activity

Tick (v') the correct answer in the D .

1. Which tab will you click to find the conditional formatting command button?

(a) View tab D (b) Home tab D (c) Datatab D
2. Bydefault conditional formatting is applied to:
(a) Selected data D (b) Entire worksheet D (c) Only one cell D
3. Which optionin the conditional formatting list will you click to clear conditional formatting?
(a) New Rules D (b) Clear Sheets D (c) Clear Rules D
Yo
by
.;81:'!,

= Aformulais an expression that is used for doing calculations on worksheet data.

= Formulae may contain mathematical operators (+, —, *, /, etc.) that help you to do addition,
subtraction, multiplication and division and so on in a worksheet.

= Functions are ready-made formulae that are built into MS Excel. They also help you to
manipulated data in a worksheet.

= Some common functions like Sum, Average, Min, Max and Count can be accessed directly from
the Auto Sum button menu.

= Sorting is the process of arranging data in a particular order.

= Filter is a feature in MS-Excel that allows you to see only the data you are interested in at a
moment and hides away the rest of the data.

= Conditional Formatting is a feature using which you can highlight selective data in a worksheet by
formatting it in such a way that it stands out from the rest of the data.

N
=)

N\

m Formula An expression that begins with a equal to sign ( =) and helps you to
manipulate worksheet data.

m Functions : Readymade in-built formulae that help you to manipulate data.

m Sorting : Arrangement of data in a particular order (increasing or decreasing
orderand soon).

m Filter : A feature in MS-Excel that can be used to temporarily hide unwanted
data.

m Custom Formatting : A feature in MS-Excel that helps you to format selective data from a
worksheet based on a certain condition.
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('CHAPTER
Check-Up

A. Tick (V') the correct answer.

1.

Which function finds the sum of the numbers in a selected cell range?

(a) Auto() (b) Sum() (c) Count()

Which function finds the average of the numbers in a selected cell range?

(a) Average() (b) Total() (c) Sum()

Which of these is an example of the absolute addressing?

(a) $A4 (b) $A$5 (c) $5

Which of these is an example of the relative addressing?

(a)C5 (b) G$9 (c) $C5

Which type of data is sorted from A to Z or from Zto A?

(a) Textual data (b) Numerical data (c) Date and Time data

Which type of data is sorted from oldest to newest data or from newest to oldest data?
(a) Textual data (b) Numerical data (c) Date and Time data

B. Fillinthe blanks with the help of given hints.

N o o NN

The Formulae in Excel must begin with an sign.

operatoris used for mathematical calculation.

The function returns the sum of the numbers in a selected cell range.
The function returns the smallest valued numberin a selected cell range.
When we sort datain order, we arrange it from the smallest to the largest.

is the process of arranging data into a meaningful order.

HINTS: Equalto(=) Sum Min Arithmetic Increasing Filter Sorting

C. Write 'T' for true statements and 'F' for false statements in the C] .

S U1 N W NN

The 'Count' function is used to find the largest value in a given range of cells.
In the function=Sum(G7:G12), the argument is G7: G12.

Arange can be used in a formula.

The conditional Formatting button lies in the styles group of Home tab.

The Sort & Filter button lies on the Editing group in Data tab.

You cannot apply multiple filters to a worksheet to view only selective data.

g30L R
o &

can be used to narrow down data in a worksheet to view only selective records.
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D. VeryShort Answer Questions.

1. Write the cell address for all cells in column C.

2. Which tab contains the AutoSum button in Excel 20107?

3. Which function will you use to find the average of numbers?

E. Short Answer Questions.
1. What does the Max() function help you to do?

2. Whatis meant by data sorting?

3. Whatis Custom Sorting?

F. LongAnswer Questions.

1. Whatisa'Formulae'in Ms Excel? Explain with the help of an example.

2. Whatis relative addressing? How is it useful?

3. Whatis absolute addressing? Explain with the help of an example.

4. What are Functions in Excel? Name the various components of a function.

5. Distinguish between sorting and filtering.

6. Whatis conditional formatting? How is it done in Ms Excel?




Practical 1: Understanding the use of absolute addressing.
1.
2.

s

. ‘ t

Do these additions to the file 'MARKS'.

Click in cell G2 and Enter the formula to
calculate the percentage marks of Anu as =
F2/B8*100.

Notice that for calculating the percentage,
the value of B8 (Max. Marks) should remain
the same for all the students. Therefore,
make the cell address B8 constant
(absolute) by clicking the formula bar and
adding a $ sign each, against both B and
($B$8) to change the formula as : =
F2/$B$8*100 in cell G2.

Click on the Enter button. ...Anu
percentage will appear in the cell G2.

Drag the fill handle to enclose cells from
G3 or G6. ...Percentages will be displayed
in these cells.

Practical 2:

1.

- —

\ e ¢,7_~.—x~g\ ,) N 2
% 8 Activity Time 5
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&

Absolute (non-changeable) cell address

Formula with absolute address copied and
applied to other cells

Create a new worksheet in MS Excel. On the sheet enter data as shown below :

Icon-X-7



Use the Sum function to calculate the sum of the marks of all the students by using the steps :
a. Clickin cell G2 and in the Home tab click on the Auto Sum button drop down arrow.
b. From the drop down menu select the Sum function.
... The Sum function will appearin cell G2.
c. Change the arguments, if required here, is no need to change the arguments.
d. Pressthe Enter key.
... The sum will be displayed in cell G2.
e. Dragthefill handle to G7 to calculate the sum for all the students.

Now select the cells B2 to F2 and open the AutoSum button drop down menu. Select the Average
function and press the Enter key. The Average marks for the first student will appearin cell H2.

Drag the fill handle to H7 to calculate the average marks for all the students.
Now use the Max () function to calculate the maximum marks obtained by Anu in any subject.
a. Clickin cell B9 and type the function = Max(B2:F2).
b. Pressthe Enter key.
... The Maximum marks will be displayed in the cell B9.
Use the Min() function to calculate the minimum marks obtained by Anu in any subject.
a. Clickin the cell B10 and type the function = Min(B2 : F2).
b. Pressthe Enter key.
... The Minimum marks will be displayed in the cell B10.

Find the number of cells containing the number values in the range B2 to E6 by using the Count()
function. The steps to do this are given below :

a. Clickin the cell B12 and insert the Count () function in it from the Sum drop down menu.
b. Now select the required data in the worksheet and press the Enter key.
... The count of the number entries in the selected cells will be displayed in the cell B2.

Save the workbook by any name.



Practical 3 : Sorting and Filtering data in a Excel worksheet.

1. Create a worksheet in Ms Excel. Apply formula to calculate the Total Marks and Percentage as
shown.

2. Sortthe datain the worksheet in ascending order of the Percentage of marks.

3. Apply a filter on the data to see the results of only those students whose names start with letter

R.
A B C D E F G H | |
1 MName Maths  science English  Hindi SST Total Max_Marks Percentage
2 |Raj 45 45 88 78 98 354 500 70.8
3 |Anu 54 87 66 64 89 360 500 72
4 |Rahul 67 56 77 98 78 376 500 75.2
5 |Vivek 90 90 66 76 67 389 500 77.8
6 |Vaibhav 89 98 58 98 75 418 500 83.6
7 | Aarohi 85 S8 96 a7 938 424 500 84.8
8 Shweta 98 39 99 a7 78 451 500 90.2
9 Vishal 89 98 87 98 89 461 500 92.2
E‘Sangini 99 98 97 94 938 486 SDDI 97.2
A B = D E F G H |
1 |Name vT_Maths - |science ~ | English| = | Hindi |~ | S5T - Total |~ Max Ma ~ |Percents =
2 |Raj 45 45 88 78 98 354 500 70.8
4 |Rahul 67 56 77 98 78 376 S00 75.2
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